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1. General 

The ReportManager is a Toolmonitor that extends the MCD TestManager. It is used for the development and 

creation of user-specific reports to document test results after a test run of the MCD TestManager. 

After execution of a test run in the TestManager, the TestManager automatically sends all test results and 

parameters to the ReportManager in the form of “enumerated data”. These can then be used to create the report. 

Up to three different reports can be defined and used at the same time. Reports are generated using the 

“FastReport” component. Help for the “FastReport” component can be found in the “Help” menu under 

“FastReport”. 

Please note that the current report data are only available after the test, that is after the “Test End” step in the next 

“Loop” step or the “Report” step. 

The main sections of this documentation are “Functions”and “Programming”. Under “Functions” you can find 

descriptions of the individual modules of the software. The “Programming” section lists the interfaces for the users 

of this software in tabular form. The interface documents the functions for access to the Toolmonitor and the 

different modules specify the valid parameter values for those functions. 

 

Figure 1: Toolmonitor ReportManager 

 

Order number: # 122353 
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2. Installation of Software 

2.1. Requirements 

 Operating system: Windows XP
®
 - Windows 8.1

®
  

 Architecture: 32 bit or 64 bit  

 . Net framework: version 3.0 

 

To install the MCD Toolmonitor ReportManager, it is sufficient simply to copy “ReportManagerMonitor.exe” into any 

directory on the target system. 

Alternatively, the installer provided (“ReportManagerInstall.msi”) may be executed. 

 

2.2. License 

To protect the software from unauthorized use, it is required to license the Toolmonitor after installation.  

For purposes of demonstrations and testing the Toolmonitor can also be operated for 30 minutes at a time without 

a license. Some program functions are disabled. A 24-hour temporary license can also be activated while waiting 

for permanent activation (for example on a weekend). 

To activate the Toolmonitor, please open the “License administration” dialog from the menu item  

License  Register. 

 

Figure 2: Calling up the Registration Dialog 

 

1.) The “Current licensing” dialog shows the status of your current license: 

 

Figure 3: Retrieving License Status 
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2.) To request a permanent license for your software, please proceed as follows:  

 Select the “Request license” dialog. 

 Specify the number of licenses needed (for your PC) in the “Number of licenses” field. 

 Click the “Generate request file” button. 

 Another window then opens to ask you to save the “MCD Licenser Request” file (*.mlr). 

 Please save this file and send it by email to info@mcd-elektronik.de. Please specify an order number or 
project number to simplify allocation. 

 You will then receive an email from MCD Elektronik with your license file (“MCD License Key *.mlk”) 
attached. 

 Finally, save this file either under “C:\Windows” or into the folder where the “.exe” file for your software was 
installed. 

 After the next start of your software, it will then be available with its full functional scope. 

 

 

Figure 4: Requesting a Permanent License 

 

3.) To activate a temporary license (24 hours), please select the “Temporary license” tab. Then enter the 

sequences of digits from the left window into the right window. If you cannot interpret the numbers, please click the 

“New number” button to receive a new number. Once you have correctly entered the number, you can activate the 

temporary license using the “Activate license” button. Please note that the temporary license will expire as soon as 

you stop the software. However, you can activate the temporary license as often as you like. 

 

Figure 5: Requesting a Temporary License 

mailto:info@mcd-elektronik.de
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2.3. Register COM Server 

This command registers the Toolmonitor as a “COM server”. This is required if the Toolmonitor will be remote 

controlled by other programs, such as the MCD TestManager. 

 

Figure 6: Register COM Server 

 

3. Report View 

Up to three report views at a time can be available in the ReportManager. A different report can be defined and 

displayed in each report view. 

 Load report: The “Load report” button can be used to load a previously stored report in “.frx” format. 
Reports in “.frx” format can be created with the FastReport designer. 

 Export: The “Export” button can be used to export the currently displayed report as an HTML report. 

 Print: The “Print” button can be used to print the currently displayed report. 

 Open: The “Open” button can be used to open a previously stored report again. 

 Save: The “Save” button can be used to save the currently displayed report in different formats. 

 Email: The “Send by Email” button can be used to send the currently displayed report by email in different 
formats. 

 Find text: The “Find text” button can be used to search in the currently displayed report. 

 Outline: The “Outline” button can be used to show a table of contents. 

 Page setup: The “Page setup” button can be used to configure the paper format for printing the current 
report. 

 Edit page: The “Edit page” button can be used to edit the current report. 

 Watermark: The “Watermark” button can be used to give the current report a watermark. 

 Navigation: The “Navigation” button can be used to select a particular page in the current report. 

 Close: The “Close” button closes the current report form. 
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Figure 7: Report View in the ReportManager 

 

3.1. Designer 

The “Designer” button opens the FastReport designer. This designer can be used to create user-specific reports. 

Help for the FastReport designer can be found in the “Help” menu under “FastReport”. 

 

Figure 8: FastReport Designer 
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4. Creating a Report (Quick Start) 

This section provides an example of the process of creating a new report with the ReportManager. Detailed help for 

the FastReport designer can be found in the “Help” menu under “FastReport”. 

 

4.1. Integrate the ReportManager into the MCD TestManager 

The ReportManager must be activated in MCD TestManager. A corresponding Toolmonitor entry must be created 

in the basic settings under “ToolManager” to do this. 

 

Figure 9: Basic Settings for the MCD TestManager 

 

4.2. Open a Report View 

To create a new report, first one of the three available report views must be opened in ReportManager. 

 

Figure 10: Opening a Report View 
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4.3. Open the FastReport Designer 

Now call up the FastReport designer from the report view. 

 

Figure 11: Opening the FastReport Designer 

 

4.4. Create a New Report 

Create a new report in the FastReport designer. 

 

Figure 12: Creating a New Report 

 

4.5. Call the Standard Reports Wizard 

To create a new report, you can also use the Standard Report Wizard. 

 

Figure 13: Calling the Standard Report Wizard 
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4.6. Select the Data Source 

Next, select the data source to be used. The data sources are organized according to the “enumerated data” in the 

TestManager. In this example, we will create a report on the overall results of all objects tested. As a result, we will 

use the “DUT data” data source. 

 

Figure 14: Selecting the Data Source 

 

4.7. Select the Data Columns 

Now select the desired data columns for the report. The figure shows some columns selected as an example. 

 

Figure 15: Selecting the Data Columns 
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4.8. Grouping the Report 

If necessary, the report can be grouped in the next step. In this example, this is unnecessary. 

 

Figure 16: Creating Groups 

 

4.9. Select a Layout Template 

Next, we can select between different layout templates. 

 

Figure 17: Selecting a Layout Template 
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4.10. Select the Color Design of the Report 

In this step, we can select between several simple color templates. 

 

Figure 18: Selecting a Color Template 

 

4.11. Specify a Sort Order for the Report 

After selecting the data area, different options can be specified for the design of the report. Among other things, the 

sort order can be specified. 

 

Figure 19: Editing the Data Range 

 

 

Figure 20: Specifying Sort Order  
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4.12. Adjust the Font Width 

After this, we recommend activating automatic adjustment of the font width for the report columns so that the 

complete data contents can always be displayed. To do this, select all data columns and set the “AutoShrink” 

property to “FontWidth”. 

 

Figure 21: Adjusting the Font Width 

 

4.13. Stop the Designer and Display the Report 

This concludes the creation of the example report and the designer can be closed now. After doing a test run, the 

report just created will be displayed. 

 

Figure 22: Displaying the Report 
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5. Project Management 

The current settings and the Toolmonitor layout can be saved and loaded from the menu options under the 

“Project” menu. All windows can be positioned freely and adjusted according to the user‘s own needs. 

 

Figure 23: Project Menu 

 

The “Project” menu consists of the following areas: 

 Save / Save as: All current settings can be saved in a project file by clicking the “Save” menu item. Even 
the current window positions will be stored in the file. 

 Load: Previously saved settings can be re-loaded by clicking the “Load” menu item. Even the original 
window positions will be recreated. 

 Import window positions: The “Import Window Positions” menu item allows the window positions to be 
imported from a saved setup file. All original settings will not be affected by this. 

 Presets: Predefined settings can be set using this menu item. 

 Close all: This menu item will close all open forms. The Toolmonitor will continue to run. 

 Local: If the Toolmonitor is remote controlled or the “Setup” has been protected with a password, most user 
actions are protected against direct entry. Activating “Local” mode removes this protection and all operating 
controls will be accessible again. If the setup process included the entry of a password, it must be entered 
to release the Toolmonitor. 

 Remote: Clicking this menu item will return Toolmonitor to protected mode. 

 Hide: Clicking this menu item will hide the Toolmonitor, but keep it running. If it is not controlled remotely, 
Toolmonitor can be re - activated using an icon on the taskbar. 

 Exit: Clicking this menu item will terminate the Toolmonitor (item will be disabled when Toolmonitor is 
controlled remotely). 
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6. Events 

The logging and trace message dialogs can be accessed from this menu. 

 

Figure 24: Events Menu 

 

The “Events” menu consists of the following areas:  

 Logging: The logging messages for general events, warnings, errors and so forth will be displayed using 
this menu option 

 Trace: The trace messages (sent or received messages) will be displayed using this menu option 

 

 

Figure 25: Log Monitor 

 

 

Figure 26: Trace Monitor 
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7. Setup 

The “Setup” menu provides access to the project-specific options and registration of the Toolmonitor as a COM 

server. 

 

Figure 27: Setup Menu 

 

7.1. General 

General Toolmonitor settings can be made from this dialog. 

 

Figure 28: General Settings 

 

The following areas are to be configured:  

 Applications title: Toolmonitor‘s window title may be adjusted. 

 Priority: Toolmonitor‘s base priority can be set using this entry. This value should only be changed when 
there is a real need to do. 

 Encrypt setup: Whether the setup should be stored in an encrypted format or not can be determined using 
this setting. In that case, Toolmonitor will be started in remote mode. In addition, a password must be set, 
which can be used to access Toolmonitor. As a control measure, this password must be confirmed. If the 
password is lost, it will no longer be possible to change the associated setup (if Toolmonitor is password-
protected, the local and remote modes can no longer be controlled). 
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7.2. Logger 

Toolmonitor‘s settings for the logging system can be made from this dialog. 

 

Figure 29: Logger 

 

7.2.1. Log Level 

This setting determines if general event messages, warnings, errors and so forth will be logged. 

The options include:  

 ExtendedDebug 

 Debug 

 Trace 

 Info 

 Warning 

 ErrorTrace 

 CriticalWarning 

 Error 
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7.2.2. Trace Level 

This setting determines the trace level for logging sent or received messages. 

The options include:  

 Streaming 

 Cyclic 

 Normal 

 

7.2.1. Log to File 

If this option is activated, all event messages will be saved in a file. The name of the file will consist of 

Toolmonitor‘s name and a timestamp. The file will be stored in the same folder as the Toolmonitor executable file. 

 

7.2.2. Log Monitor Background Update 

Normally, event messages are always generated, even when displaying event messages has not been enabled in 

the monitor. If that is not desired, this feature can be deactivated using this option. 

 

7.2.3. Log Errors Always to File 

Normally, error messages will always be written to an additional log file. If that is not desired, this feature can be 

deactivated using this option. The name of the file will consist of Toolmonitor‘s name and the literal “Exceptions”. 

The file will be stored in the same folder as the Toolmonitor executable file. 

 

 

8. Remote Control by MCD TestManager CE 

MCD TestManager CE can be used to remote control an MCD Toolmonitor. You can find more information about 

this functionality in the “Programming” chapter and in the “General Help” for the Toolmonitors. 
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9. Programming 

9.1. ReportView 

This is a class for displaying a report. This class provides functions for displaying a report. 

 

9.1.1. VirtualInterfaceCommands 

Names for the commands of the virtual interface are defined here. These names are used to trigger the commands 

“SetEvent” and “SetValue” in the virtual interface. 

Example: 

            SetEvent("Refresh"); 

            SetEvent("Print"); 

            SetEvent("Export.PDF"); 

            SetEvent("Export.HTML"); 

            SetEvent("Report", "C:\Sample.frx"); 

 

Enumeration values: 

Report Loads the report to be used currently in “.frx” format 

Export Exports the current report as HTML or PDF 

HTML Specifies the export format as HTML 

PDF Specifies the export format as PDF 

Print Prints the current report 

Refresh Updates the current report 
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